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EasyCode, ValveBank and ValveLink are trademarks of AutoMate Scientific, Inc.

Apple and Macintosh are registered trademarks of Apple Computer, Inc.
IBM-PC is a registered trademark of International Business Machines, Inc.
Windows is a trademark of Microsoft Corp.

1. Copyright   This manual and the software described in it are copyrighted with all 
rights reserved.  Under the copyright laws, this manual (or documentation on disk) 
or the software may not be copied, in part or in whole, without written consent of 
AutoMate Scientific, Inc., except to make one (1) backup copy of the software.  The 
same proprietary and copyright notices must be affixed to any permitted copies as 
were affixed to the original.  This exception does not allow copies to be made for 
other individuals or any other computers, whether or not sold.

Under the law, copying includes translating into another language or format.  You 
may not sub-license, lease, lend, rent, or grant other rights to all or any portion of 
the software or documentation, except as expressly provided for in this agreement 
without the written permission of AutoMate Scientific, Inc.

2. License   You are authorized to use this software on a single computer; and 
copies for this purpose ONLY will be permitted.  Inter-departmental and network 
use require the purchase of multiple copies of the software or a multi-use license.  
(Contact AutoMate Scientific, Inc. to obtain information on multi-use licenses.)  
PLEASE respect the time that we have put into this project and give your friend a 
copy of our address instead of a copy of the software.

3. Transfer   All of the material purchased (with all backup copies) may be sold or 
given to another person or organization if you notify AutoMate Scientific, Inc., who 
will then transfer ownership registration and customer support to the recipient.  
The new possessor will then be legally bound by the same terms and conditions 
of this agreement.
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Getting Started

Welcome to EasyCode® – an accessory program for the Valve-
Bank™ line of automated valve and pump controllers.  EasyCode 
provides a simple ‘click-and-drag’ interface for programming on-off 
sequences using graphic timebars.  Researchers can save and load 
these programs to a hard disk, print out program listings, then 
download completed programs into the ValveBank’s memory in 
one simple step.  Once downloaded, the program remains in the 
ValveBank’s memory, and the ValveBank can then be disconnected 
from the computer.  EasyCode does not currently support direct 
control of the ValveBank or connected valves from your computer.  
Programs must be downloaded into the ValveBank, then ‘run’ using 
the ValveBank’s keypad.

Hardware and software requirements
EasyCode needs the following minimum configuration to run:
Macintosh:
•  A Macintosh 512E or later model
• 2 MB under System 7
•  System 6.0.5 or later, OS 9 and X (Classic) compatible
• Temporary use of one serial port or USB port
• Serial cable (AutoMate supplied 'null modem' cable)
• USB-to-serial adapter

IBM:
• An IBM-PC or compatible with 2MB RAM
• Microsoft Windows 3.1 to 95 (EasyCode 2.0)
 Microsoft Windows 98SE, 2000, XP (version 3.0)
• Temporary use of one com port
• Serial cable (AutoMate supplied 'null modem' cable)

Macintosh/Windows basics
If you're new to the Macintosh or Windows, you may want to 

familiarize yourself with these basic skills.  This manual assumes 
you know how to:
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Starting and quitting EasyCode
You start and quit EasyCode like any other Mac/Windows ap-

plication.  Double-click the EasyCode icon in the EasyCode folder.  
Macintosh users can double-click saved ValveBank program files to 
launch and load them.

To quit, choose Quit {Exit} from the File 
menu.  If you have made changes to a program 
file and have not saved them, EasyCode asks if 
you wish to save or discard them.

Serial port set-up
EasyCode must communicate with your 

ValveBank through a serial {com} port with the 
provided cable.  PC's and Macs are equipped 
with multiple serial ports located on the back 

panel of the case – you may use any one.  For ex-
ample, if the printer {com} port is already used by 
a printer or network cable, insert the serial cable in 
the modem port {a different com port}.  You must 
tell EasyCode which serial port you are using 

through the Preferences menu {Serial port sub-menu} option under 
File. (Also see pg. 20)

Newer Macintosh and PC computers without serial ports re-
quire a USB-to-serial adapter - available from AutoMate.

ValveBank 4 and 8
The Preferences {Hard-

ware sub-menu} option 
allows you to configure 
EasyCode for use with either 
the ValveBank4 or 8 control-
ler.  This affects the number 
of channels used and serial 
transfers.

•  Open an application
•  Move a window, change its size, and close it
•  Choose a command from a menu
•  Enter information in a dialog box
•  Use a scroll bar to scroll through a list or through infor-

mation in a window
•  Select an item in a window by clicking it with the mouse
For details, see your Macintosh or Windows documentation.

Before you install EasyCode
Before you install EasyCode, we recommend that you:

• Check the system requirements on the previous page.
• Make backup copies of your EasyCode product disk, and 

use the copies for installation or use.
• Take a moment to fill out and mail your registration card.  

As a registered user, you will receive important product 
support and update information.

To install EasyCode Macintosh
You can use EasyCode Mac directly from floppy disk (re-

member to always use a backup disk instead of your original).  
However, execution, loading and saving ValveBank programs will 
be faster and more convenient from a hard disk.

To install EasyCode Mac on your hard disk:
1. Create a new folder on your hard disk named EasyCode.
2. Copy the EasyCode floppy disk into this new folder.
OR:  Drag the floppy disk icon onto your hard disk.

To install EasyCode PC/Windows
1. Double-click the setup installer on the floppy disk.
2. Follow screen instructions for drive and directory choice.

An extra folder named “Samples” contained on the EasyCode 
floppy disk is optional and may be deleted if desired.  It contains 
the sample ValveBank programs listed in the ValveBank manual.
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Macintosh and PC-Windows Differences

While every effort has been made to keep the Mac and Win-
dows versions of EasyCode identical, several differences exist.  
Some relate to nuances or conventions of the respective operating 
systems ('Quit' is called 'Exit' in Windows), while others are actual 
programming changes.  Sample screens throughout this manual 
are taken from the Macintosh version, but should be functionally 
identical to Windows.

User's guide notation
References to menu choices and dialog boxes throughout 

this instruction manual are generally universal to both versions of 
EasyCode.  However, subtle wording differences are noted with 
{brackets} for the Windows specific notation.  For example, a refer-
ence to serial {com} ports means they are called com ports on the PC 
and serial ports on the Macintosh.  Macintosh keyboard shortcuts 
usually use the command key (⌘-S for Save), while Windows uses 
the Ctrl key (Ctrl-S).

EasyCode PC window with Preferences sub-menus

Choosing active channels
This release of EasyCode supports up to 16 ValveBank chan-

nels in a single program.  This corresponds to four networked 
ValveBank4’s, two ValveBank8’s, or any combination thereof.  
EasyCode always groups channels in fixed ”banks“ of four (1-4, 5-8, 
9-12, 13-16).  A program intended for an eight channel ValveBank8 
will be treated as two 
“banks” of four channels.  
Since the groups of four 
channels are fixed, a pro-
gram using channels 3, 
4, 5, and 6 would have to 
be transmitted as bank 1 
(ch. 1-4) and bank 2 (5-8) 
even though it only uses 
four channels. Choose 
Select Channels under 
the Experiment menu 
to change the number 
of channels used in a particular experiment.  Check boxes with X’s 
represent active channels.

Speed tip:  Screen redraws will be faster with fewer channels.  
Turn off any unused channels for quicker response.

If you program in a bank of channels then turn those channels 
off, any programming in the disabled channels will NOT be lost – it 
simply is not displayed.  Return to the Select Channels option to 
view the hidden data.
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Preferences
The Preferences option under the File menu (sample screen 

previous page) differs between the Macintosh and PC.  The Macin-
tosh Preferences dialog box shown on page 6 includes serial port, 
ValveBank4/8, and guides options.  These three options appear as 
sub-menus on the PC.  The actual settings are functionally identical 
between the two platforms.

Note:  Most EasyCode settings apply only to the current docu-
ment (select channels, display interval), or individual timebars, 
but changes made to Preferences settings apply to all documents 
opened on that copy of EasyCode.  Preferences settings are stored 
with EasyCode, and will be preserved next time you run the pro-
gram.

Macintosh auto-scroll timebar editing
The Macintosh version offers automatic screen scrolling as 

you create, edit, or move timebars off the left or right edges of the 
screen.

Using EasyCode

At this point you need to begin associating the channels you 
see in EasyCode with the channels on your ValveBank(s).  For a 
ValveBank4, channels 1 through 4 represent valves and *TTL’s

1 through 4.  Taken another step, you should associate channel one 
with the solution to flow through valve one or accessory controlled 
by TTL one.  The small notes box below each channel number allow 
you to keep track of what each channel is controlling.

Experiment notes
By selecting the Notes option under the 

Experiment menu, you can enter a message up 
to 255 characters long pertaining to the particular 
experiment you are working on.  This window is 
stored when you save a program to disk, and is 
independent of any notes typed into individual channels.

*  TTL stands for Transistor-Transistor-Logic, a +5/0 volt standard for representing on and 
off – used by the ValveBank to control and monitor external devices.  See the Technical Notes 
chapter of the ValveBank manual for more information and uses.
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Valve and TTL timebars at Display Interval 1 minute

Display Units are used here

The same valve and TTL commands at Display Interval 10 minutes
with buzzers and loops turned off

Display Interval corresponds to this period of time

Several additional commands facilitate quick jumps to specific 
times in your program.  ‘Begin Display From’ brings-up a dialog 
box in which you may type a new starting display time.  The screen 
will update with this new time at the left margin. This command is 

available from the Display menu 
or by clicking the rectangle in the 

lower left corner of the programming window or by typing its key-
board short-cut (⌘-B).

The large and small 'mountain' icons (Mac only) zoom the dis-
play interval in and out respectively.

The Home Display command under the Display menu imme-
diately jumps the display back to time zero (short-cut: ⌘-H).

Customizing your display
In general, you will adapt the EasyCode window to the Valve-

Bank system you use most often.  For speed reasons it is most effi-
cient to turn off all of the channels and rows that are not in use.  The 
Show option under the Display menu allows further control of what 
is displayed in the EasyCode window.  For users who do not need 

TTL’s, loops, buzzers, or valves, 
the Show sub-menu under Display 
allows these rows to be selectively 
turned off and on.  As with Select 
Channels, programming in a row 
that is subsequently turned off is 
not lost.  It will re-appear when 

those rows are later displayed, and when the program is Listed to 
the screen (see p. 19).

Zooming in and out of your program
The Display Interval sub-menu under Display allows you to 

adjust the length of time drawn horizontally across the screen.  If 
you are using very short valve or 
TTL commands, you will need to 
select a shorter time interval for 
the timebars to be accessible.  Like-
wise, if you are creating a very long 
program and want to see a greater 
length of time displayed, choose a 
higher interval.  The selected interval corresponds to the width of 
the grey guides on screen (see next page).

(⌘-< and >) { , and . (comma and period) on the PC} will 
zoom in or out one interval respectively, as will the small and large 
'mountain' icons on the Mac (see next page).

You may also wish to 
adjust the units in which time 
is displayed on screen. Time 
units correspond to the values 
printed above the top of the 
window. Hrs:min:sec may be 
the most flexible.
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5.  Double-click a timebar or choose 
Get Info under Edit menu to 
access the info dialog box for a 
selected timebar.

Type new time values.
Tab key advances to the next 
entry box. TTL In Options are 
explained in the TTL chapter.

Color and Duration only appear on 
the Mac version of EasyCode.  
Duration is immediately updated 
whenever the start or end times are
modified. See Custom timebar 
colors (p. 31) for more color info.

☛  Double-clicking a very small timebar may be difficult.  Shorten 
the Display Interval (zoom in) or click once and choose Get Info.  
Alternately, choose the next timebar to the left or right, and use Tab or 
Shift-Tab to select the small timebar, or use the marquee (next page).

6.  Drag inside a timebar to move it.  Delete key deletes selection.

7.  Cut, copy, and paste under the Edit menu will duplicate or move 
timebars between channels or programs.  Note:  You cannot paste a 
timebar overlapping an existing one – EasyCode will beep.  Move one.

Programming in EasyCode

Programming sequences for ValveBank valves, TTL’s, buzzers 
and loops is accomplished by dragging timebars in specific rows of 
the desired channels in the programming window.  These timebars 
represent when an activity will occur (i.e. when a valve will be open 
or buzzer will be on).  The sequential examples below will step you 
through creating and editing timebars.

1.  Click in a channel to make it active – its rows become shaded.

2.  Click and drag (left to right only) inside a valve, TTL, buzzer or loop shaded 
row to create a timebar.  Use the time indicator in the upper left corner and 
the grey vertical interval guides as references.

3.  Drag the small corner squares to resize timebars.

4.  Click once on a timebar to select it, click between rows {upper time indicator 
bar on PC} to de-select.  When a timebar is selected, the Tab key selects the 
next timebar (to the right), and Shift-Tab selects the next timebar left.

Undo under the Edit menu (⌘-Z) / {Ctrl-Z} reverses 
the last change made.
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Guides
Vertical guides (grey lines) automatically appear below each 

'Display Interval.' Additionally, user defined guides (blue lines) 
can be created to facilitate lining-up events at the same time across 
channels.  Guides must be activated under the Guides {Snap-to}

Preferences dialog under the File menu.  They are created on the 
Mac by clicking or dragging in the white bar where the time units 
are displayed.  On the Windows version, they are created by drag-
ging left to right from the channel headers, then a dialog box 

3.  Cut, copy and paste work for group selections as well as delete and 
move.  Click once in a channel to highlight it as a paste destination.

Group selecting
EasyCode now supports selecting, moving, copying and past-

ing multiple timebars.  In order to change several timebars at once, 
they must first be selected.  Selecting a group of timebars can be 
accomplished in several ways:

• Holding the Shift key down while clicking on timebars alter-
nately selects and de-selects them - adding or removing them from 
the current group selection.

• Dragging a rectangle (marquee) around timebars selects all 
timebars touched or enclosed by the marquee (see below).

• Clicking in a row (valve, ttl, etc.) selects all timebars in that 
row - even if off screen.  Clicking in a channel header (grey box on 
the left side of each channel except for the channel notes box) {or 
between rows on the PC} selects  all timebars in that channel.

• Holding Shift down while clicking on a row or header allows 
an entire row to be added or removed from the current selection.

Click here to select all timebars in a channel

1.  Drag a marquee to select several timebars, or hold the Shift key to add 
or remove timebars from the current selection.

2.  Timebars in a group selection appear with a heavy border {hollow 
corner boxes on the PC}.

Click in a shaded row to select all timebars in that row
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Listing your program
You can see your entire program as it will look in the Valve-

Bank by choosing List Program (⌘-L) under the Program menu 
(shown on next page).  A List window appears – complete with 
program and channel notes.

Remember, if a channel has been programmed and then turned 
off using Display Channels, that programming is not erased and 
will appear in the List window.

Scroll up and down to review the listing, choose Print from 
the File menu for a hard copy of the ValveBank program, or choose 
'Save as text file...' from the File menu to store a formatted ASCII 
listing of your program to disk.  This text file can then be read with 
any word processor.  EasyCode cannot read text file programs.

Editing in the List window
Individual commands can be edited from the List window by 

double-clicking them.  A standard Get Info dialog box will appear 
from the timebar associated with the command.  Once changes have 
been made, click OK and the List window will be updated.

Guides continued...
appears for entering an exact time or removing the guide.  Once cre-
ated, user guides can be moved by dragging them, and deleted by 
dragging them back off the left edge of the screen.

Guides are useful visually for lining-up timebars, but their real 
strength is when 'Snap-to-guides' is turned on in the Preferences 
dialog.  Thereafter, timebars 'snap' to the nearest user or interval 
guide when being created, resized, or moved.

Programming tips
Open and Save program files under the File menu as with any Mac 

or Windows application – even open several programs at once.

☛   You are limited to 32 timebars per channel (64 events max).  
☛   Save (⌘-S) frequently!

Group tips
->> PC Only:  You cannot drag a timebar that overlaps the 

edge of the screen or lies off-screen.  Be careful selecting entire rows 
or channels.  The Mac version will automatically scroll left or right 
as you drag off the screen.

->> Any time a 'Multi-channel' loop is included in a group 
selection, all of its linked 'partners' and inner nested loops are auto-
matically included.

->> Get Info does not apply to a group.  However, you may 
Get Info on an individual timebar without disturbing the group 
selection by clicking on it, (the timebar appears with an individual 
selection outline) then choosing Get Info.

Graphic printing
Choose Print from the file 

menu to print a graphic view of 
your program.  Select how much 
of your program to print with the 
print screen dialog box.  Enter by 
time duration on the Macintosh 
and number of pages on the PC.
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Multiple ValveBank transfers
If you have more than four channels active under Select Chan-

nels, EasyCode will prompt you with a check box for which ‘banks’ 
of programming you wish to transfer.  Each bank represents four 
channels of programming and is transmitted individually – see 
Choosing active channels (p. 8).

ValveBank4’s accept one bank and ValveBank8’s can receive 
one or two banks (a 4 or 
8 channel program).  If 
you are using several 
ValveBanks as a network, 
you must transfer banks 
of programming to each 
one.  When EasyCode 
has completed sending 
the first four channels, 
disconnect the serial 
cable from the first ValveBank, connect it to the second, and click 
send.  The order in which to send to several ValveBanks will be 
determined by the solutions and valves represented by the channels 
in EasyCode – keep track!  Repeat this process for each ValveBank 
(one or two banks to any ValveBank8’s).

Receiving programs
Programs can also be received from ValveBanks for editing on 

your computer.  This might be necessary if you have made changes 
or done fine tuning to ValveBank programs using the keypad on the 
controller and now wish to maintain the revised code in EasyCode.

1. Choose Receive... under the Program menu in EasyCode so 
that it indicates “Ready to receive.”

2. Choose Serial Mode on the ValveBank and select Send.
3. Choose the source program number, and press Enter to 

begin the transfer.  After transmitting, EasyCode performs 
a verification of the data and the ValveBank should display 
“Successful Send.”  A new program window will be created 
in EasyCode.

Communicating with the ValveBank

In the ValveBank programming language all of the timebars 
become a start and end command pair (see your ValveBank manual 
for a full description of the commands available).  After selecting a 
timebar, its starting and ending times are accessible using Get Info 
(⌘-I or double-click) under the Edit menu.

Sending programs
1. Check your cable connections to both computer and Valve-

Bank – see Serial port set-up (p. 7).
2. Make sure the ValveBank is plugged in and turned on.
3. Scroll to Serial Mode on the ValveBank and select “Receive.”
4. Enter a program number in which to save the incoming code
5. Press Enter until the ValveBank screen reads “Ready to 

receive.”

On the Macintosh or PC:
1. Choose Send... under the Program menu.  

This will create a List window of the Valve-
Bank code about to be transferred (de-
scribed on the previous page) and perform 
a consistency check for errors.  A program 
with errors cannot be sent – see the Consis-
tency section (p. 26) to help identify the problem.

2. See the next page for multi-ValveBank programs, otherwise 
click Send to begin the transfer.  A progress box will show 
four channels of programming being transferred to the des-
ignated ValveBank memory slot.  The ValveBank performs 
an internal verification and should display “Successful 
Receive” upon completion.

3. ValveBank8’s will prompt you to send a second bank of pro-
gramming.  Press Cancel at this point to save one bank.

If EasyCode has difficulty and retrys sending, see pg. 22.
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Loops

Loops are used to simplify repetition of sequences in a single 
channel, or in several channels as a multi-channel loop.  They are 
created, modified, copied and transmitted much like other timebars.  
The following examples should help clarify loops:

1. Draw a loop to enclose other timebars to be repeated.

2.  Creating a loop immediately 
brings up its info box so you can 
enter the number of iterations to 
repeat the loop.  This can always 
be changed later.

☛ Limit of 99 iterations
☛ Limit of 16 loops per channel

3.  A heavy black rectangle appears below and right of the new loop.  This 
represents the time that the loop is repeating (the loop’s second iteration in 
this example).  During this time, the channel is occupied repeating the loop 
and its contents. Do not create timebars in this repetition area.

4.  The loop row is extra wide to allow for ‘nesting’ loops up to four deep (on 
top and inside one another).  Inner loops and their repetition areas must 
all lie within their containing outer loops.

☛ You must delete nested loops in reverse order or EasyCode beeps.

NO timebars here

Troubleshooting serial transfers
Both the sender and receiver of ValveBank serial data transfers 

perform a data verification step.  If a discrepancy is found, you will 
hear a beep, and the sending device will attempt several retrys.  Oc-
casionally, your computer and the ValveBank will get out of sync 
with one another during sends and retrys – especially if the serial 
cable is disconnected during a transfer.  Often a serial Receive by 
EasyCode will re-synchronize both devices.  If several sends to the 
ValveBank are beeping as unsuccessful:

1. Cancel the transfer on both ends (click Cancel or type
⌘-period on the Mac and press Cancel on the ValveBank).

2. Send any program from the ValveBank (even a blank one) 
and receive it in EasyCode.

If successful, you should then be able to send correctly from 
EasyCode to the ValveBank.  The window of the dummy program 
received by EasyCode may be closed without saving it.  If this 
Receive also fails, however, check the cable connections.  Are 
you sending to several ValveBanks?  Is the serial port being used 
selected under Preferences in the File menu?  Finally, try turning 
the ValveBank off and re-starting the EasyCode application on 
the Mac or re-starting Windows and EasyCode on a PC.  If all else 
fails, contact AutoMate Scientific for technical support at the phone 
number on the back of this manual.

Serial cable
EasyCode transmits to ValveBanks using a standard 'null' 

modem cable with the following simple wiring:

  2   2

  3   3

  5   5  (ground)
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Multi-channel loops appear in blue on color systems.

Here a nested (inner) loop was added inside a channel with a multi-channel 
loop.  This automatically lengthens the containing loop in channel 2 to 
compensate for the new repetition time (see example 6 on previous page), 
which, in turn, lengthens all of the other linked multi-channel loops.

Click Multi-channel.
Select the channels you wish 

the multi-channel loop to 
appear in.  The channel it 
was originally drawn in 
is automatically included 
and grayed-out.

Individual loops can also be 
‘disconnected’ later from 
the multi-channel link by 
un-clicking them.

5.  When moving a loop timebar, its outline becomes as long as its total rep-
etition length.  Also, you are automatically constrained inside any outer 
loops (the loop in the example above cannot move any farther right).

6.  Creating or changing the number of iterations or the start/end times for 
a loop alters its repetition area and automatically lengthens or shortens 
any outer loops.  Any timebars beyond the loop will also be moved left or 
right to prevent overlaps.  Example:  The number of iterations has been 
increased from two to three for the inner loop.  Now its iteration rectangle 
is twice as long and the outer loop has increased as well.

Multi-channel loops
Draw a loop in any channel and click Multi-channel in its info 

box to make it a multi-channel loop.  Identical loops will appear in 
all channels you check in the info box.  Multi-channel loops are spe-
cial structures that facilitate repeating of sequences across several 
channels.  Once created, they are linked to one another so that alter-
ing one will change all of its partners.

Create an ordinary loop or select an existing one.
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TTL Input options

Three TTL Input options are available to instruct the Valve-
Bank to react to external signals through its TTL Input port.  See the 
TTL Input Commands sub-chapter in your ValveBank manual for 
a full description of the commands that these TTL options translate 
into.  Access the special options through the usual Get Info box for 
any valve timebar - not TTL’s:

Sample timebars of each TTL In option (l to r:  mirror, trigger on, trigger off)  
White inner lines in second two timebars represent their ‘Trigger Time.’

Selecting TTL Enabled un-greys 
three TTL In options.  Enter a 
Trigger Time (length) for either 
TRIGGER ON or OFF.

☛ Trigger time must be less or equal 
to the total length of the timebar.

Mirror               The valve will ‘mirror’ its channel’s TTL input 
during the timebar:  While the TTL input is High, 
the valve will be Open, TTL Low = Closed.  Open/
closed logic can be inverted on the ValveBank.

Trigger On        Instructs the ValveBank to begin watching the TTL 
input associated with its channel.  When that TTL 
input goes High, that channel’s valve will open (like 
a Mirror above), but only for the amount of time 
specified by the Trigger Time.   If the TTL input is 
already High when the TRIGGER ON command is 
processed, the valve is opened immediately and

All of this may seem excessive simply to keep ‘multi-channel’ 
loops tied together, but if either the starting or ending time of 
one channel’s loop was individually changed, its channel would 
quickly lose sync with the others it was meant to coordinate with.  
EasyCode handles all of the hard work for you.

Multi-channel loops may be nested, but may only be the 
outer-most loop.  Any channel may contain a total of up to 16 loops 
with any combination of nesting (up to four deep) or multi-channel 
loops.

The ValveBank has no multi-channel loop command.  Easy-
Code automatically generates LOOP START and LOOP END com-
mands in each participating channel at exactly the same times.

Consistency (error-checking)
The Consistency sub-menu under Program allows you to 

check selected timebars or entire programs for illegal structures:  
illegal timebars in loop repetition areas (see example), too many 
events (> 32 timebars), or too many loops in a channel (> 16).  You 
may also turn active warnings on and off.

Illegal timebar

You cannot place a timebar during a repetition area (shown by the black 
rectangle when a loop is repeating) or you will generate the following error:

Move or delete the offending timebar to eliminate the error.  Below:  The same error 
while the loop is selected.  You could move the loop or change its iterations.
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Timing diagrams  (Sample TTL input is bottom graph)

High

Low

t=0 5 sec. 10 sec. 15 sec.

VALVE ON 00:00:00.00
TRIGGER OFF 00:00.05.00

TRIGGER ON  00:00:05.00
TRIG LENGTH  00:00:

TTL RESPOND  00:00:05.00
TTL IGNORE 00:00:16.00

(disables TRIGGER ON or 
OFF)

On

Off

On

Off

On

Off

On

Off
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Sample TTL  INPUT:

TRIGGER ON  00:00:04.00
TRIG LENGTH  00:00:
02.00
VALVE OFF  00:00:05.00  

Trigger On        timed according to the Trigger Time as usual.
(cont’d)             TRIGGER ON only triggers once.  Use loops to 

repeat trigger (see below).  A VALVE OFF command 
is included at the timebar’s end time to discontinue 
the pending TRIGGER ON command or override 
any Trigger Time remaining.

Use a loop to trigger repeatedly.  This example will open valve one for up to 10 
minutes out of every 30 minute period as many times as the loop repeats.

Trigger Off        EasyCode translates the Trigger Off timebar into a 
VALVE ON command at its start time then a TRIG-
GER OFF command at the end time minus the 
Trigger Time entered.  The TRIGGER OFF instructs 
the ValveBank to watch its TTL input (like a TRIG-
GER ON), but, when the TTL input goes High, the 
ValveBank CLOSES that channel’s valve.  Finally, 
the TRIGGER OFF timebar is discontinued with a 
VALVE OFF, just like a TRIGGER ON, to make sure 
the valve closes at its end time.

See the Timing Diagram on the next page and the Computer Interfacing 
chapter of the ValveBank manual for more TTL input information.

☛  Remember ValveBank8’s only have TTL Inputs for their  
first four channels.  EasyCode lets you use them in any chan-
nel not knowing which banks may be transmitted later as 
channels 1-4.

The TTL Inputs can be used for computer (or other timer) 
interfacing – allowing a computer to operate valves using the 
ValveBank as a driver; to respond to sensor inputs (pressure, tem-
perature, flow or level sensors, bubble detectors); to deliver timed 
feedings; or otherwise react to TTL-generating devices.
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Custom timebar colors
Macintosh:  Colors of individual timebars can be changed in 

their Get Info box.  Click on the color box to display the standard 
Apple color picker.  Start by sliding the right scroll bar to its top.  

Then choose a 
color by clicking 
inside the wheel, or 
typing numbers di-
rectly into the small 
boxes on the left.  
Click OK to finish 
color selection and 
return to the dialog 
box.  All EasyCode 
color boxes default 
to black which 
displays in the 

standard timebar color for the corresponding row.  Setting a timebar 
back to black returns it to the internal default color.

Windows:  The PC version of EasyCode includes a Prefer-
ences sub-menu under File for color selection.  This dialog box lets 
you define new colors for timebar rows (valve, ttl, loops, etc.) and 
timebars.  Select the item 
you wish to change from 
the short list, then use the 
sliders for red, green, and 
blue to select a new color.  
Clicking Default returns 
that item back to its internal 
default color.

Advanced Features & Tips

Speed screen display
• Eliminate unused channels (Select Channels under the 

Program menu).
• Turn off unused rows (use Show under the Display menu).
• Try the Black & White (not color or greys) setting in the 

Monitors control panel.

Multiple documents
EasyCode allows you to have any number of 

program files open at once.  Open files are listed 
under the Experiment menu where you can eas-
ily switch between them.  Cut, copy and paste 
across documents to combine programs or pieces 
of programs.  Use the Windows menu on the PC to Tile, Cascade, 
Arrange, or Close All open document windows.

Mac - PC file sharing
EasyCode on both platforms read each other's files.  Transfer 

EasyCode files by high-density disk or network.

Typing in a program
You cannot type ValveBank commands (as shown in the List 

window) directly into EasyCode from the keyboard.  However, if 
you wish to type a program from a print-out or notes with precise 
times, simply click-and-drag timebars anywhere in rows as you 
need commands (valve, TTL, loops, etc.) and immediately select Get 
Info to call its info box (p. 15).  Here you can type any start and end 
times – even if it will completely reposition the timebar.  Hence, you 
simply drag-create timebars anywhere quickly, then type in new, 
valid times and repeat through your listing for each pair of on/off 
commands and all channels.
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(which would overwrite the sample file) if you make changes and 
want to keep the original sample files.

Special thanks to Susan Abrahamson and the Grussem lab at 
U.C. Berkeley for the Silver Stain protocol and program.

Please calibrate the sample templates to your system and test 
before using them.

Send in your warranty card and we will keep you updated on 
new releases of EasyCode and additional sample templates.

Keyboard shortcuts
Many EasyCode features can be accessed by keyboard.  Hold 

command (⌘) or Ctrl down while pressing the following keys:

N New program  X Cut
O Open file   C Copy
S  Save file   V Paste
W Close window  I Get Info
Q Quit EasyCode  Z Undo
P  Print window

< {,} Zoom out   Error checking:
> {.} Zoom in   J Selection
B  Begin from   K Program 
H Home (zero)
L  List program

Tab Select next timebar right
Shift-tab Select previous timebar left

Dialog boxes:
Tab Jump to next entry box
Return or
Enter OK
Esc Cancel

Graphic screen snapshots
In addition to printing the graphic timebar window (p.18), you 

can also capture a disk image of the current screen.  Arrange the 
entire screen exactly as you want (scroll and position windows and 
increase the Display Interval under the Display menu to fit more 
across the screen).

Macintosh:  Press ⌘-shift-3 on your Macintosh keyboard.  Af-
ter a brief pause, a new PICT file named “Picture 1” will be created 
on your system hard disk.  Subsequent ‘snap shots’ are numbered 
“Picture 2...” sequentially.  These PICT image files are of the whole 
screen, menu bar, background, arrow cursor, open dialog boxes and 
all.  They may be large files, especially on big color monitor systems 
– try a sample.  These PICT files may be opened by most graphic 
software; imported into many word processors, page layout, and 
slide presentation programs; or even translated into a PC-compat-
ible format with the appropriate software.  If subsequent print-outs 
are ‘muddy’ because of difficulty printing greys, switch the Moni-
tors control panel to Black & White (not greys) before taking the 
snap shots.  This creates smaller files on your hard disk too.

Windows users:  Press the PrintScreen key, and a screen snap-
shot will be created in the Windows clipboard.  It can be displayed, 
modified, printed and saved using PC Paintbrush that comes with 
most PC systems.  If subsequent print-outs are ‘muddy’ because 
of difficulty printing greys, switch the Monitors control panel to 
Black & White (not greys) before taking the snap shots.  This creates 
smaller files on your hard disk too.  Alternately, adjust the palette in 
PC Paintbrush.

Sample files
Be sure and check the folder of sample files included on your 

EasyCode disk (remember to use a back-up copy or from hard 
disk).  All of the samples found in the back of the ValveBank man-
ual are included as well as several newer examples.  These pro-
grams are intended as templates.  You will almost certainly need to 
modify them for your own configuration (solutions and accessory 
channels), calibration (flow rates and fill times), and specific timing 
requirements.  Remember to do a Save As... (which will allow you 
to save with a new name and to a different drive) instead of a Save 
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Warranty

AutoMate Scientific, Inc. warrants its products against defects of 
workmanship and/or material for ONE YEAR from the date of sale.  Any 
product that fails to perform as specified may be returned, freight pre-paid 
to the factory (with a written explanation of the problem) for examination 
and repair or replacement.  If it is defective, AutoMate Scientific will repair 
or replace (at our option) the product without charge and return it to you.

If the examination indicates that non-compatible fluid, destructive 
environment, accidental damage, modification or abusive practices have 
occurred, all labor, materials and freight costs shall be at the expense of the 
customer.  Due to the nature of research laboratory applications, AutoMate 
Scientific, Inc. will NOT accept the return of any products which have been 
used with HAZARDOUS MATERIALS or in a harmful environment.

This warranty is in lieu of all other warranties, whether oral or 
written, express or implied.  In no event shall AutoMate Scientific, Inc. or 
its licensor/licensees be liable for contingent, special, direct, indirect or 
consequential damages for the breach of any express or implied warranty 
or resulting from the use, failure or malfunction of any product, including 
damage to property and, to the fullest extent permitted by law, damages 
for personal injury, even if AutoMate Scientific, Inc. has been advised of the 
possibility of such damages or if this warranty is found to fail its essen-
tial purpose.  If you choose to use this program, you agree that AutoMate 
Scientific, Inc’s liability is limited to the reimbursement of the cost of the 
product or program licensed to you.  All other warranties, including, but 
not limited to warranties for fitness or merchantability for a particular 
purpose are expressly excluded. No verbal changes to this policy will be 
authorized.  DISCLAIMER:  AutoMate does not warrant that the program 
is free from all bugs, errors, and omissions – only that it operates substan-
tially as described in this User’s Manual.

AutoMate Scientific, Inc. manufacturers and sells goods in accor-
dance with U.S. federal, state and local laws, but assumes no responsibility 
or liability for laws, regulations, duties, or taxes imposed by any foreign 
country.  All terms and conditions hereof shall be governed by the laws of 
the State of California.  Some states do not allow the exclusion or limitation 
of implied warranties or liability for incidental or consequential damages, 
so the above limitations or exclusions may not apply to you.




